UORUM
STREAM

USER GUIDE

~<odestuff®



Table of Contents

1 Installation and ACHIVALION ........cooiiiiiiiiiiiii e 3
PrEIEQUISIEES. ..ttt e e ettt e e e e s bbb et e e e s eabbe e e e e s e bbb e e e e ereeae s 3
INStalling QUOTUM SEFEAMN ......eiiiiiiiiiiee ettt ettt ettt e e e ettt e e e e e st e e e e e santbeeaeeeaannneaaeeannns 5

OFfliNE ACHVALION ..o esnneas 5
Activating a Trial Version of QUOIUM SEFEAIM ........ccccuviiiirieiiiiie i 7

2 Getting Started ........coooiiiiiiiieeee 8
Starting the QUOIUM SEFEAM SEIVICE ......cciiuiiiiiiii ittt ettt 8
Configuring the Quorum Stream Service .9

WX (o[ To J- W D=1 ot USROS PPPRP 1
CrEAtiNg SESSIONS .....eiiiiiiiiiiiii ettt e et e e e e et e e e e e e s bbb et e e e s aabbe e e e e e e sbbeeeeeeanbbeeeeeans 12
(DI o] =N T g To Y Ao [=To RSP URTI 13

Displaying Video in @ Webh BrOWSET ..........oiiiiiiiiiieiiiiee et 13

Displaying Video on a Mobile PhONe...........cccooiiiiiiiii e 14

Displaying Video in an RTSP-capable Video Player (QuickTime/VLP)...........ccccoveveennene. 14

Displaying Video using QUOTUM Play ..........cccoiiiiiiieiiiiiis e seiee e ssiiaee e esiraee e 14

Displaying Video using Quorum View or QUorum Wall ............cccoiiiiiiiiiiiiiieeeiieeee e 15
Programmatic Control of QUOIUM SEFEAM .........eeiiiiiiiiie e 16

Appendix A Maintenance Information.............ccoooooiiiiiiiiiiiiiiiiiiiiie
Opening a Command Prompt in Microsoft Windows
Opening the RUN IAl0G ... ..ciiiiiei et e e e e e e
Finding out the IP Address Of YOUr COMPULET .......cccvieiiiieiiieeiiie e
Determining PC POrt USAQE ... .uvviiiiiiiiei ettt ettt e et e e e et e e e e s sataa e e e e s e anraeae s
Windows Events — Using the EVENt VIEWET ...t
Configuring Application Log to Overwrite Oldest ENtries...........covuiiiiiiieiiiiniiieeee e 26
Viewing WINAOWS SEIVICES LIST.....cccuuiiiiiiiiiiiesiee et 26
Checking Connectivity of a Networked Device or COMPULET .........cccvverieeerieeeininie e 28
TrOUDIESNOOTING ...ttt as 29

Providing Technical Support INnformation.............cccoociviiiiiiiiiiie e 29

20f31



Chapter 1 — Installation and Activation

Quorum Stream is a streaming service that services requests coming via web-pages hosted by
the Stream Service itself, or from applications making use of the Service's web services
interface. Video can then be viewed on any RTSP-compliant video player, such as QuickTime
or VideoLan Client (VideoLan Player).

The Quorum Stream service can also work in conjunction with the rest of the Quorum product
range; Quorum View provides viewing support in a simple surveillance suite, and streams from
Quorum Stream can also be viewed on the Quorum Wall video-wall.

Prerequisites

Hardware
* Intel Core2 Duo processor

» 2GB DDR2 RAM
¢ 1Gb Ethernet NIC

Operating System
» XP Pro SP2 operating system

Additional Mandatory Software
» .Net Framework 3.5, Windows 3.1 Installer (automatically installed)

» Direct-X 9.0c (March 2009 or later) (manual installation required)

* Microsoft Internet Explorer version 7 or later (manual installation required)

Note: Microsoft frequently re-designs its web-sites therefore an Internet download link is not
provided. Instead we recommend that you use Google or another search engine to find
the download links for the mandatory software. On examining the search results, please
ensure that the download source is Microsoft.

Operating System Settings

The computer should have the operating system installed either by the computer manufacturer
or from the operating system installation media. The computer is assumed not to be the
member of any Windows network domain.

Note: Changes to the operating system settings, such as changing the local or global policies
relating to rights and permissions, are discouraged. These notes assume that the
operating system is set up in a fresh installed state.

Quorum Stream installation, .Net installation, Direct-X components installation and all
maintenance should be carried out as the administrator user.

To prevent unscheduled system restarts, switch off the automatic Windows update feature.
Updates of the Windows operating system should be carried out as a part of scheduled system
maintenance.

Networking

Set up the network settings for the computer and make sure that the computer network
connection is enabled and connected. Check this by opening a command prompt and running
the ipconfig Windows command-line utility, see Appendix A.

The computer must be set up so that it can browse the Internet. Following installation, Quorum
Stream will need to contact a licensing server located on the Internet in order to complete the
installation and activate.
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Firewall Information

Quorum Stream requires an open HTTP port on any local software firewall. On starting, the
service will attempt to service clients on port 80 (the standard HTTP web-page port). If this is in
use, then the port serviced will be port 8000, then 8001, and so on. You should also open port
554 to allow transcoded streams to be streamed out of the server. If port 554 is already in use,
the port used will be 7000, then 7001 etc.

Any local software firewall should either be disabled, or carefully configured so as not to prevent
Quorum Stream from contacting the licensing server. Also, any hardware firewall on the LAN
should be configured to allow appropriate network access to the computer on which Quorum
Stream is executing. Some local, software-based firewalls block incoming/outgoing traffic solely
on a port number basis. Others block ports to all but explicitly defined applications.

Table 1 Firewall-related setup data

Application Role Default Path Port number Note
setup.exe Client installer  installation media 80/TCP The main installer for
Quorum Stream

QuorumStream.exe  Activation C:\Program 80/TCP Required to enable Quorum
Files\Codestuff Stream
Ltd\QuorumStream

QuorumStream.exe  Application C:\Program 80/TCP * Access to Server Service
Files\Codestuff 554/TCP ** application

Ltd\QuorumStream  25776/TCP***

* The stream tries to use port 80 or 8000, 8001 or 8002, up to 8005 until an unused web port is found
** The stream tries to use port 554 or 7000, 7001, 7002, up to 7005 until an unused RTSP port is found
***The stream usees port 25776 for web services.

Note: Blocking required ports and/or not allowing Quorum Stream and related applications to
use the network can prevent successful installation, activation or execution of Quorum
Stream.

Please ensure that the following ports are open:

« The Web Server port that was set up when configuring Quorum Stream e.g. 80, 8001,
8002, 8003, 8004 or 8005.

* The RTSP port that was set up when configuring Quorum Stream e.g. 554, 7001, 7002,
7003, 7004, 7005.

» The Web services port for Quorum Stream remote control: 25776.

Additional Security Software

It is not advisable to execute the following on the computer running Quorum Stream unless the
impact of their execution is considered carefully:

e Anti-virus
* Anti-spyware

» Software firewall.

.Net Framework

The installation program for Quorum Stream will automatically download the correct version of
the .Net Framework. However if preferred, install the .Net Framework prior to installing Quorum
Stream. No configuration of the .Net Framework is required.

Windows 3.1 Installer

The installation program for the .Net will automatically download Windows 3.1 Installer if
required.
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Installing Quorum Stream

1
2

5

Log in to the computer as administrator.
Run the Quorum Stream setup.exe program.

This automatically examines the local system for the .Net Framework. If this is not present,
or it is an earlier version, the installer program automatically connects to Microsoft's servers
over the Internet and downloads the correct version of the software.

Note: By default, the installation directory is C:\Program Files\Codestuff Ltd\Quorum
Stream. To change this, click Advanced on the licence dialog.

After accepting the terms and conditions, you are prompted to license Quorum Stream. You
can:

» use atrial licence. Trial licences allow access to all standard functionality, but video
panes have text obscuring the video being displayed. If you later upgrade to a full
version, you must activate that version; see “Activating a Trial Version of Quorum
Stream” on page 7.

* use an existing licence from a previous installation.

» license Quorum Stream offline. Use this option if you are installing Quorum Stream on a
PC with no internet access. See “Offline Activation” on page 5.

* enter a new licence key to activate Quorum Stream. You must obtain a licence key from
your vendor before continuing with the installation.

If required, enter the licence key you have been given and click Check License. The system
indicates whether or not the activation has been successful.

Click Next to complete the installation.

If activation fails, please check the following:

Have you used the correct Activation ID?

Has a trial Activation ID expired?

Has the Activation ID already been used by a different computer?
Have there been too many hardware changes to the computer?

Have you turned off the CPU ID feature of your PC or are using hardware identity masking
software? If there are insufficient identifying characteristics, then the licensing server cannot
license your PC.

Are you using machine virtualisation software such as VirtualPC or VMWare? You must use
native hardware rather than virtualised hardware.

Could something be preventing an Internet connection — e.g. firewall block?
Could the activation server be busy? Wait a while and try again

Do you have sufficient account rights to write licence file to local hard disk? Ensure you are
attempting to license Quorum Stream using an account with administrator level privileges.

In geographical regions where different calendar types are used, please ensure your
regional Date/Time setting is set to use the Gregorian calendar.

Offline Activation

Note: This section applies only if you selected Use Offline Activation during installation.

If the computer on which you are installing Quorum Stream is not connected to the internet, you
can activate Quorum Stream from a computer which is connected, as follows:

1 Select Use Offline Activation during installation, then click Next.

2 Navigate to the folder where you want to save the licence data, or accept the default and

click Save License Data.
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i Quorum Stream §|

Quorum Stream Offline Activation UORUM
Offline Licensing - Save Licensing Daka STREAM

Press the 'Save License Data' button below to save a licensing data file and a web link
file to disk. Copy both to a PC with internet access, and use the web link file to
access the Quorum Stream Activation page.

Save ko Folder: |C:'|,D0cuments and SettingsiMy Documents), Browse..

Save License Data

icense Data and Web Link succesfully saved 3
icenseData, bxk and LicenseWeblink.url

[ Back “ Mext ] [ Cancel

Figure 1 Offline licensing

3 Navigate to the LicenseWebLink.url file and open it to access the activation page:

RapidCCTV License Activation

This page allows you to activate a RapidCCTV license for & computer that does not
have internet access

Flease fill in the form below and press the Save License button.

Flease enter the activation code as provided by your supplier.

dB216349-f158-45Gd-a957-16594bf43ce

Please browese to the file containing licensing data generated on the computer you wish
to license:

‘clivatiun\LwcenseData.bcl

IAdivateLicenSe ” Save License I

Your license was successfully activated.

Pleage press the Save License button to download it.

The license file should then be copied to the cormputer where the license data was
generated

[

&

Figure 2 Activation web page

4 Enter the activation code you have been given, and browse to the folder where the licence

data was saved.

5 Click Activate License, then Save License.

6 Save the licence to the computer where the licence data was generated.

7 Return to the License Activation dialog and click Next, then enter the activation code.

Browse to the folder where the new licence data has been saved, and click Copy Activated

License.

Installing Quorum Stream
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Quorum Stream Offline Activation UORUM
Offline Licensing - Copyw Ackivated License STREAM

Once an Activated License Ffile is acquired, enter the license key and the File's Folder
and filename below, Then press the button below b copy vour activated license file
ta the License Store, thereby completing Offline Activation For Quaoruni Strearn,

License Key: |56c489d?-2b32—483?-9635—fd61?ch645?
Copy from ... |C:'|,Documents and SettingsiiMy Documents), Browse, ,

File name:  |RapidCCTyLicense.ral

License succesfully Activated and Copied! . - -

[ Back ][ et ] [ Cancel

Figure 3 Offline activation

8 If activation has been successful, click Next to continue the installation process. If not, see
“Installing Quorum Stream” above for reasons why installation might have failed.

Activating a Trial Version of Quorum Stream

Note: The following section applies only if you have first installed a trial version of Quorum
Stream.

Prior to unrestricted use, the full version of Quorum Stream must be activated. Activation is
performed over the Internet and requires an activation ID. Activation is a one-time process.
Once activated, a non-trial activation ID does not need reactivating.

Note: Activation IDs are tied to various products even though they look very similar. Please be
sure that you use a Quorum Stream activation ID.

Once an activation ID is used it is tied to the identity of the computer used to activate it. If for
some reason the licence file generated by activation is lost, then the ID originally used to license
Quorum Stream can be reused to re-activate Quorum Stream.

To activate a full version of Quorum Stream:
1 Locate the Quorum Stream component in the Windows Start menu.

2 Start the Quorum Stream License Helper application.

% adobe Photoshop €52
& Internet Explorer

= Auto Start Service

L Start Service
45 Stop Service
ﬁl Uninskall Quorurn Strean
C} Canfiguration \Webpage

Figure 4 Activating a full version of Quorum Stream

« If your computer is connected to the internet, enter the Licence Activation Key you have
been given, then click Activate Licence. Activation can take a few seconds. Activation
success, or failure, will be indicated.

« If your computer is not connected to the internet, click to activate Quorum Stream offline,
and follow the instructions in “Offline Activation” on page 5.

If activation fails, see “Installing Quorum Stream” on page 5 for possible reasons.
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Chapter 2 — Getting Started

Once you have installed and activated Quorum Stream, you are ready to configure the
streaming service. This chapter deals with the following:

» Starting the Quorum Stream Service
» Configuring the Quorum Stream Service
» Creating Sessions

» Displaying Video

Starting the Quorum Stream Service

You are now ready to start the Quorum Stream service. You can choose either to start and stop
the service manually, or to have the computer automatically start the Quorum Stream service
whenever it starts up. The Quorum Service runs either under the LocalService or
NetworkService account.

Starting the Service Automatically

To start the Service now and have it start automatically in future choose the Auto Start Service
option from the Start menu.

rﬂ Programs M Quorum 'E-r'earru
1) Quorum Yiew

¥ | Quorum Stream License Helper

(5] o Documents Y IE cuickTime b Start Service
=}
B ﬁ") Apple Software Update oL Stop Service
o E' Settings » . i
%J ~ ¥ ﬁ! Uninstall Quarum Streamm
Configuration \Webpage
a /-J Search 3 @ ! pag
& Q Help and Support
]
E 3 Run...
-
=
£ (0] shut cown..
-

# start VNG e

m
I—.

Figure 5 Starting the service automatically

Starting the Service Manually

To start the Service now, but have manual control over it starting in the future, choose the Start
Service option from the Start Menu.

fi Quorum Skream

uﬂ Quorum Yiew

Programs

by |4 Doruments i) QuickTime 4
(=]

= (™) Apple Software Update
= G’ Settings p |2 AR "

= :

= /-_J Search L4

& 0’ Help and Suppart

- B

E #=] Run..

h=

£

; iol Shut Down,..

r e "

/s start D@ e

Figure 6 Starting the service manually

A Windows console is used to initiate starting and stopping of the Service. Occasionally the
Service takes longer than the Service Control Manager considers a normal start-up time. In this
case a warning is printed. This can usually be ignored. If concerned, the most accurate way to
ensure that the Service has fully started is to use the Windows Event Viewer application from
Administrative Tools in the Control Panel to examine the Windows Application Log.
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The application should show the following entries when the Service is running. It also indicates
the web and RTSP port numbers that the stream service is connected to.

B Event Viewer

File  Action  Wiew Help
e+ mmE B @

Event Yiewer (Local)
Application

Type Date Time Source Category  Event | Us#

Microsoft Ofice Disgnostics || &2 Informetion Event Properties

Micrasoft Office Sessions Dinformation  03j02]

Event
(ENrfarmation  rinz| |
<

Date:  [EEENDE Source:  Service Control Manager

|
Time: 13:0054  Categom: Mons
|

Tupe: Information  Ewent |0: 7036
User. N2
Computer: MOMTFORT

Description

Starting service with following ports:
RTSP Port = 7000
“wieb Config Part = 8000

For more information, see Help and Support Center at
http: !/ go. miciosoft comfwlink/events. asp,

Figure 7 Successful startup of Quorum Stream

Quorum Stream Service is now ready to use.

Configuring the Quorum Stream Service

To configure Quorum Stream:

1 From the Start menu, select the Configuration Webpage option.

um Stream 5| Auto Start Service

CQuorum Yiew

Programs

¥ |7 Quorum Stream License Helper

2 |__"‘ Dacuments * ) QuickTime v/ (g Start Service

= I

1 (%) apple Software Update 45 Stop Service

3 ) Settings » 7 Anp . " -*5 _D

%-‘ N ¥ ﬁ Uninstall Quorurn Stream
a /J Search 3 age
% @ Help and Support

- I

g 4= Run...

-

=

£ (0] shutDown...

7Z start U@ E

Figure 8 Configuration Webpage option

The Session Config web page is displayed.
2 Click System Info on the left of the web page.
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UORUM

Sessian Config
Device Config

System Info

STREAM

m”c’:‘%destuff'ﬁ

Application Infarmation:

Wersion:

1.0.5630.71

Wersion Date:

02/03/2009 14:27:15

RTSP Port:

7000

Default RTSP Port:

554

Active Sessions:

3

Maximum Sessions:

1%

Active Clients:

0

Uptime: 0 days 0 mins
Bandwidth (Input): OKbps
Bandwidth (Output): OKbps
Players:

Download VLC Player: Click Here
Download Quicktime Player: Click Here

Windows Mobile Player:

Kinoma Play (Commercial

Application Settings:
Default Network Address: 0.0.0.0

Default RTSP Port:

554

Default Web Port:

a0

Figure 9 System Information

3 Here you can alter the default network address and default RTSP and web ports.

» Default Network Address — If you have more than one network card, specify which card

the streaming server should bind to.

» Default RTSP Port — If you wish to change the default RTSP port from 554, enter the
new value here. If the changed default port is in use, then the port serviced will be 7000,
then 7001 etc

» Default Web Port — If you wish to change the default web port from 80, enter the new
value here. If the changed default port is in use, then the port serviced will be 8000, then
8001 etc

Caution: You must restart the Quorum Stream service for any changes to take effect.

To do this:

1 Stop the Quorum Stream service from the Start menu (Start>Programs>Quorum

Stream>Stop Service).

2 Verify that the stream service has stopped:

» Open the Windows Task Manager to ensure that the stream service has disappeared, or

» Check that the Windows Administrative tools Event Viewer has an entry in the log

showing the service has stopped, or

» Use Windows Services to check that the service is shown as stopped.

Configuring the Quorum Stream Service
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3 Start the stream service from the Start menu (Start>Programs>Quorum Stream>Start
Service).

4 Verify using the same applications as in step 2 that the service has started.

Adding a Device

Once you have started the Quorum Stream service, you must add the devices you want to
stream from:

1 Select Device Config on the left of the web page. The Device Config page lists the devices
already created and allows you to add new devices.

2 Select a device from the drop-down list.

SR, ™cod estuff.i

Session Config Platform: Basch MPEG4 Device v
Device Config

Parameter Value
System Info

Address (e.g. 192.168.0.1[:80]) 10.062.1

Input Channel (e.g. 00, 01, 10, 11) ]

MName BoschCamera

Description Some additional information

Username service

Password A2n 3|

| Add Device
Device Action
\\ BoschCamera
fharburn/10.0.62.1/video/source/mpeg4/00 Delete
Some additional information

Figure 10 Adding a device to Quorum Stream

3 Enter the configuration details as follows:

* Address — The IP address of the camera (or encoder). In Figure 10, a Bosch VIP x2
encoder is being added with IP address 10.0.62.1.

* Input Port — Identifies which camera (on which encoder). If you only have one camera,
enter 0. In Figure 10, the input of 00, which is a code for analog video input 1, encoder 1,
indicates the video source.

* Name — The name that the device will be known as in Quorum Stream. In Figure 10 the
device name is BoschCamera.

» Description — (optional) A brief useful comment about the device.
» User Name — (If applicable) Enter the user name used to access the device.

» Password — (If applicable) Enter the password associated with the user name.

Configuring the Quorum Stream Service 11 of 31



4 Click Add Device. The device appears on the web page. The stream service will how
request a video stream from the device. The stream received will use the settings defined
when that device was configured using software provided by the device's manufacturer, or
via web-pages as described in the device maufacturer's user guide.

Note: For Bosch devices, the input codes are 00, 01, 10, 11, 20, 21, 30, and so on. The first
number represents a zero-based analog input number, and the second number a
zero-based encoder number. e.g. Analog input 2 encoder 2 would be described as code
11 to the Stream service.

You are now ready to create a session to view video. Sessions describe to the Stream Service
how it should transcode the native stream being received from a device.

Creating Sessions

The Session Config web page lists existing sessions and allows new sessions to be created. A
session describes how the stream service should transcode the stream from a previously added
device. Different resolutions, framerates, quality (Q)- values or bitrates and I-frame insertion
intervals can be set. This allows the original stream from the chosen device to generate a hew
stream in the manner specified.

To create a new session:
1 Click Session Config on the left of the web page.
2 Enter the configuration details for this session as follows:
* Format — The encoded video format that you want to use.
* Resolution — The encoded video resolution of the output stream
* Framerate — The frame rate of the output stream
« Bitrate/Quality
» Bitrate — ensures a constant bit rate (CBR)
* Quality — uses a variable bit rate (VBR) to ensure constant video quality
e |-Frame — The number of seconds between key frames
* Name — The name for this session. Session names must not contain spaces.
» Device — The device from which video is streamed in this session
3 Click Create Session.

Note: If you have already created the maximum number of sessions allowed, the Create
Session button is greyed out.
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UORUM . -~
STREAM e d t -H:
codesiu

Session Config Saceion Action
Device Config
System Info Format: MFEGE

Resolution: CIF (352288) o]

Framerate (fps): 10 =

Mode: & Quality

O Bitrate

Quality: e

|-Frame (Seconds) 10 =

Name: TranscodedBoschCamera

Device: BoschCamers

| Create Session|

{ UORUM " °

STREAM - d t -H:
codesiu

Session Config Saccion Actian
Device Config

TranscodedBoschCamara
Systern Info ow vidoo

in webpags 1 o Play
S b i in wirhag s Widool AN Playit Dastioy
risp:/A10.0.1.7:5 roadearter/videal tource /TranscodedBorchCamera

Dwvica: BerichCamars, Farmat: MPEGA, Wilth: 357, Height: 88, Fps: 10, Quality: 20, IF rame: 30000,

Format: MPEGA [»

Figure 11 Creating a session

Quorum Stream is now actively transcoding the stream from the device, and the new session
will be listed along with existing sessions.

Note: When you have created a session, you can use the System Information page to check
the number of active streams and clients listed.

Displaying Video
You can display video using Quorum Stream:

* onweb browsers running on Windows, Macintosh or Linux operating systems. Assumes that
QuickTime browser plug-in or VideoLan Player browser plug-in has been installed.

e on a mobile phone using Windows Mobile Player.
» using RTSP-capable video players, such as QuickTime and Quorum Play.

» using Quorum View running on a Windows PC, or on Quorum Walls controlled by Quorum
View.

Displaying Video in a Web Browser

To display video in a web browser, you must have installed QuickTime or VideoLan Player.

Note: To download these, click the links on the System Config page.

To display video, click the session link for the session you have created. For example, in
Figure 11 this is /broadcaster/video/source/TranscodedBoschCamera.
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Video is displayed in a separate pane:

e -

UORUM - -
SIREAN codestuff™ |

Session Config
Device Config

System Info

7

Start :Stog?

Figure 12 Displaying video in a web browser

Displaying Video on a Mobile Phone
To display video on a mobile phone, you need a URL suitable to use with the phone.
Note: To display video, you must be using Kinoma Play or Real Player on an S60 3rd edition

Nokia Series Mobile. Video is displayed only over wireless networks or on 3G networks
with open UDP ports.

A URL is created when you create a session and is shown on the Session Config page. In
Figure 11, the URL associated with the TranscodedBoschCamera stream is:

rtsp://10.0.1.13:554/broadcaster/video/source/TranscodedBoschCamera
1 Copy the URL to the clipboard.

2 Open Kinoma Play or Real Player, and paste the copied URL into the appropriate stream
source field.

3 The video stream is displayed on the mobile phone.

Displaying Video in an RTSP-capable Video Player (QuickTime/VLP)
To display video in a separate player, you need a URL suitable to use with the player.

A URL is created when you create a session and is shown on the Session Config page. In
Figure 11, the URL associated with the TranscodedBoschCamera stream is:

rtsp://10.0.1.13:554/broadcaster/video/source/TranscodedBoschCamera
1 Copy the URL to the clipboard.

2 Open an RTSP stream player, such as QuickTime, and paste the copied URL into the
appropriate stream source field. In QuickTime this is done by using the File>Open URL
menu item.

3 The video stream is displayed in your chosen player.

Displaying Video using Quorum Play

The Quorum Play application is an RTSP-capable video player provided along with Quorum
Stream.

To display video from the streaming service using Quorum Play, you must first install Quorum
Play on your PC, as follows:

1 Log in to the computer as administrator.

2 Run the Quorum Play setup.exe program. You are prompted to enter the folder where you
want to install Quorum Play.
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3 Click Finish.

4 Launch Quorum Play from the Start menu.

E e M@ Quorum Flay ' Quarum Play
Cuiorum Wiews 3 ﬁ! Uninstall Quorurm Play

= Lg' Documents 4 Quorum Stream 4
= :

— () Apple Software Update
2 -’ Settings 4 4 e "

@ ¥

< s

= /_) Search 4

% “} Help and Support:

w

E 4=] Run...

=

=

= iOI Shut Down...

74 start SE=N NG

Figure 13 Starting Quorum Play

5 When the application opens, select Open Stream from the File menu, and enter the address
of the stream you want to view:

Open Stream

Type the address of a Stream and the player will open it

far pout.

Open; |rts|:|: £410.0.30 5554 ivestream v |

Figure 14 Opening a stream using Quorum Play

This should be in the format:
rtsp://IPaddress:port number/????

6 Click OK to view the stream.

Displaying Video using Quorum View or Quorum Wall

To display video from the streaming service using Quorum View, you must add Quorum Stream
Server as a device to Quorum View. For details on how to add a device to Quorum View, please
see the Quorum View User Guide.

Once you have added Quorum Stream as a device, the streams which you have created are
visible in Quorum View, as shown in Figure 15:
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Figure 15 Displaying streams in Quorum View

To display a stream, drag and drop the stream name onto a video pane.

Note: To display a stream on Quorum Wall, drag and drop the stream onto a video pane on a
Quorum Wall, as shown in Figure 16:

Quorum View -_‘@@
|
= g
Ex ]
=52 Quorum Stream
O &k Camcras
& Caneiall |
&2 Camera 02
&4 Camera 03 ; UO RUM
VIEW
eUORUM UORUM
WVALL WALL
~Eddestuff®
B e B et fecsi
EalzE] EEEFREE
2 G UORUM UORUM
1 (i VIEW
I Recordings | "
[ Views |
[ Alarms. |
| e | ~Zodestuff® ~Zodestuff®
=4, Quorum StreamCameras/Camera 02 Recorder: Running

Figure 16 Viewing streams in Quorum Wall

Programmatic Control of Quorum Stream

In addition to controlling Quorum Stream using web pages, it is also possible to interact with it
via a web-service as follows:

1 Ensure that you have the latest version of Quorum Stream. This is available from

http://codestuff.net/products/quorum/quorum-stream.aspx.
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2 Start the Quorum Stream service by using the start menu Start>Quorum Stream>Start
Service. Itis good practice to check that the service has started, as described in “Starting the
Quorum Stream Service” on page 8.

Note: The Quorum Stream service must be running when developing, and when adding or
updating your Quorum Stream web-references.

3 In Visual Studio solution explorer, choose Add Service Reference. In the Add Service
Reference dialog click Advanced. In the Service Settings area, right-click References and
select Add Web Reference.projects (Figure 17):

8 QuorumStreamWebDemo - Microsoft Visual Studio
Fle Edt View Project Buld Debug Data Toos Test Window Help

PIREEE A= N b Detg z i il
i iE &= " L@

¥ Prognmes rami.cs e - x

g ! vl |2 s 3

— 1| [ Soubon ‘QuorumStreamviebDemo’ {1 prol
| = (7 QuorumStreamWebDemo
% [ Properbes

g | cieence: |

@ EJFe Add Reference...
:j m Add Service Refe(!.'xe]
atic class
< >
e main encry po r the |[|[cRSobmen ... (B ]
FPropertes >3 X

atatic void Main()

.EnableVisualSzyl

<

Error st
@ 0&rrors | [y 0 wamings| [() 0 messages

L Fe L. Coumn | project
< >
(5 Eror Ut [Ty Output | S P Resu... | amFrd sym... |Lgere

Ready

Figure 17 Service Settings area

Note: Quorum Stream has a self-describing web-services interface accessible at:
http://127.0.0.1:25776/RapidGateway/. If you are using Visual Studio 2008, then please
note that you should use Web References for Web-Services 2.0 rather than Service
References.

4 In the Add Web Reference dialog, enter the http address for the web-service
(http://127.0.0.1:25776/RapidGateway/) and click Go.

Add Web Reference Elle

Navigate to & web service URL and click Add Reference to add all the available services.
G i 3 a
[CPlY - /127.0.0.1:25778 RanudGateway | v| Qe
Web services found at this URL:
Start Browsing for Web Services

Use this page 85 o starting paint to find Web services. You can dick the ks
below, e type a known URL into the address bar,

Browse to:
= Web services in this solution

= Web services on the local machine

= Browse UDDI Servers on the local network
Query your local retwork for UDDT servers,

Figure 18 Add Web Reference dialog

Note: In some installations the end slash is removed.

If the Stream service is executing and no firewalls prevent access to the service, the web
reference dialog will be displayed:
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Add Web Reference

)
E5

Navigate to & web service URL and dick Add Reference to add &l the avadable services.
G Bax " MR

WRL: | hittp://127.0.0, 257 76/RapidGateway .,J Ga

RapidGatewayServer Service 1

You have created a service.

w

Web gervices found at this LRL:
1 Service Found:

To test this service, you will need to create a client and use it to
call the service. You can do this using the svcutil.exe tool from the
command line with the following syntax:

svcutil .exe heep://10.0.1.313:35776/rapidgat:

'Web reference name:

This will generate a configuration file and a code file that containe
the client class. Add the two files to your client application and use
the generated client class to call the Service. For example:

| Add Reference

ce

clazs Test
{
static void Main()
i

Figure 19 Naming the web reference

5 Choose a name for the Web reference. This will become the namespace for the Quorum
Stream web-service in your project, then Click Add Reference. In Figure 19 the arbitrary
name GatewayWSsS has been chosen.

Visual Studio will now create proxy classes to access the Quorum Stream web service.
These will be added to the namespace set in the previous step. Make sure you add a using
statement to any code file that references the Stream server, e.g using
QuorumStreamWebDemo.GatewayWs

“a QuorumStreamWebDemo - Microsoft Visual Studio

Efle Edt View Project Buid Debug Data Tools Test Window Help
s 5 i & b Debug x P
S e L EEE o] o 3 e

| Program.cs®  Formi.cs [Desgn] R Bl Solustion Explorer - Solution ‘Quor... = & X

2 @ V[ Sl BLAE]

8 I - [ Solution 'QuorumStreamWebDemo' (1 &
S using System; =/ L :
e » | = [F QuorumStreamWebDemo

using System.Collections.Generic:
2 Sk g s @ (i Propertes
A o SR @ |23 References
using Sysctem.Windows.Forms: 3 Service References
= (1§ WebReferences
o
% app.config
O namespace QuorumStreanWebDemo cs &
| ¢
B >
- static class = =
I t ew | 5] Docume.
Ax
=] >3 x
| ry point for the
| GatewayW$ Folder Properties -
| =]
|: ola; Metn () Folder Name GatewayWws
URLBehavior  Dynamic
carion.EnableVisualStvl ¥
& alisacion.FoabisVix al.:r.n)l Web Reference LR http://127.0.0.1:25776,
Error List > 2 x
FU"E"““J L[\Dwamqsﬂy 0 Messages |
C Fle L..| Column Project
Folder Name
< ¥ || Name of this folder
I BFi -+ | (@ Breaipoint

Figure 20 Adding a using statement

6

Create an instance of the RapidGatewayServer class to represent the Stream server and

then, later, assign the URL of the server e.g. http://127.0.0.1:25776/RapidGateway by
setting the URL property of the RapidGatewayServer object.

private RapidGatewayServer m_server = new RapidGatewayServer();

m_server.Url = http://localhost:25776/RapidGateway;

When performing asynchronous actions using the RapidGatewayServer class you should
subscribe to events in the class that relate to the completion of the required action.
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For example, to list all the trancoding sessions on a Quorum Stream server asynchronously
the ListSessionsAsync method is called, e.g.
m_server.ListSessionsAsync();

Then, to complete other actions you might have associated with obtaining the list, you add a
method e.g. OnListSessionsCompleted with a signature and method body similar to the
following:

void OnListSessionsCompleted( object sender, ListSessionsCompletedEventArgs
e)
{
if ( InvokeRequired )
{
Beginlnvoke(

new ListSessionsCompletedEventHandler(

OnListSessionsCompleted ), new object[] { sender, e }

);

}

else

{
// Do rest of work

3
3
The OnListSessionsCompleted method declared above is called after the list of sessions are
available from the Quorum Stream server. Note that since the thread that calls the method
might not be on the same thread that created the RapidGatewayServer object, you must test
whether thread invocation is required and perform the invocation using the appropriate
delegate defined for the method being invoked. This is atypical of implementing callbacks in
C#.

Note: You must also have previously subscribed to the ListSessionsCompleted event, as
shown below.

m_server.ListSessionsCompleted +=

new ListSessionsCompletedEventHandler(OnListSessionsCompleted);

Implementation Hints

Prior to making a call to the Stream server, always check that the server is active by calling
the GetGatewaylnfo RapidGatewayServer method within a try...catch block.

Handling errors in callbacks — Typically, event handlers have an e parameter which
contains an Error property. If null, then it can be assumed that no error occurred and any
data included in the e parameter is valid. If e.Error is not null then e will contain a reference
to an Exception class.

E.g.

protected override void OnLoad( EventArgs e )

{

base.OnLoad( e );

try

{

// Check Quorum Stream is reachable

m_server .GetGatewayIlnfo();

// Obtain current session list

m_server.ListSessionsAsync();

3

catch (Exception ex)

{
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MessageBox.Show(ex.Message) ;
¥
}

» Please download and open the Visual Studio 2008 C# project from our website
(http://codestuff.net/support/fag/how-do-i-use-quorum-stream-with-web-servic
es/qgstream-web-control ler-demo-.aspx). This implements a simple Windows Forms
GUI application which connects to a Quorum Stream server running on the SAME PC that is
running the application, and:

« Automatically lists all sessions available on the server.
» Allows multiple transcode sessions to be created with different Transcoding parameters.

» Allows deletion of previously created trancode sessions.

Quorum Stream Web-Services control demo

New Session

Source |fbruc:ef|eld,-’1D.DT].11fwdeofsourt:e;’mjpegfnphMot\oaneg'?ResoleDn=E4Dx4E| Usemame | |

O Bitrate kbps () |-Frame-rate ms

(*) Quality 75 w | % () |-Frame only Persist []
Sessi.. | Target Name ConnectionString
Jbrucefield/10.0.71.11/video,/source/mjpeg./nphMotionJpeq ?Resolution=64 (480 ttsp:/localhost:554/broadcastes

7adb3k... /harbum/10.0.62.1/video/source/mpegd/0 stream0  rtsp:/Aocalhost:554/broadcaster

< | 4

Right-click on existing sessions for menu. Click stop to end selected session. or copy target string. Paste copied sting into Guorum Play to view.

Figure 21 Quorum Stream Web Services control demo

The application requires a knowledge of the correct source "target string" to allow you to
make a connect to a particular device.

For Panasonic BLC-1 with IP address 10.0.71.11 this is:
/brucefield/10.0.71.11/video/source/mjpeg/nphMotionJpeg?Resolution=640x480
For Axis MJPEG with IP address 195.243.185.195 this is:
/oakbank/195.243.185.195/video/source/0

After creating a session you can view it using Quorum Play (download from our website at
/products/quorum/quorum-play.aspx).

To view the session:

1 Right-click a session and choose Copy connection string.
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l! Quorum Stream Web-Services control demo

New Session

Saroe [fookbank /195 243 185 195/ Wieo/source/) | Wsewsme | |

Hame: 'slmam Resolution t_}CIF v/ Password | .

C) Brate |54 v kbps @) Hrameste 10000 v ms

@outy [ 9| 5 O rame only Persist []
| 1340f5.. /brucefield/10.0.71.11/video source/mipeg/nphMotionJpeg *Resolution=64(x480  stream2  nsp/Aocalhost 554 /broadcaster|
| Fadb36.. /harbum/10.0621/videa/source /mpagd/0 stream(  tsp.//focalhost: 554 broadcaster
[itbball. . | foakbank/195.243.185. 155 mdeo/sca=s i streamd | nsp/ocalhost 554 broadeaste

_{ Stop session
Copy connection string

| >

Faght-click: on endsting sessions for menu. Cick stop to end selecled session. or copy taget string. Pasta copied sting into Guorum Play to view.

Figure 22 Copying the connection string

2 Open Quorum Play.

3 Choose File>Open Stream from the Quorum Play menu, and right-click the Open

combo-box and paste in the connection string.

4 Click OK. Quorum Play will now show the stream that has been generated by Quorum

Stream with the transcode parameters selected at session creation time.

Quorum Play

0 - <

Figure 23 Displaying a stream using Quorum Play

Alternatively, you can use Apple QuickTime.

1 Start QuickTime
2 From the File menu select Open URL, and paste in the connection string.
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Figure 24 Displaying a stream using Apple QuickTime
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Appendix A — Maintenance Information

The follow section provides useful information regarding the general use and setup of the
surveillance system.

Opening a Command Prompt in Microsoft Windows

The command prompt allows certain tools that do not have a graphical user interface to
execute. Often such commands require extra parts, called arguments, that detail what options
need to be configured.

For instance, the networking command ping allows the network connections to another
networked device to be tested. The main argument required is the IP address of the device, e.g.
ping 10.11.12.13

Note: Often the commands executed at the command prompt require certain privileges,
therefore it is important to use the command prompt as an administrator level user.

Windows XP

To access the command prompt, click Start menu>All Programs>Accessories>Command
Prompt. It is also often started from the Run dialog (see below) by typing cmd and clicking OK.

In the command prompt window, enter the required command at the prompt after the >
character. After typing the command, press Enter to perform the command.

INDOWS\system32\cmd. exe

rosoft Windows XP [Uersion 5.1.2680]
C Copyright 1985%-2881 Microsoft Corp.

IC:“Documents and Settings .

[EE)

= Type the name of a program, folder, document, or
= Inkernet resource, and Windows will open it for wau,

Open: | emd

OK H Cancel I[ Browse...

Figure 25 Opening a Windows command prompt

Opening the Run dialog
To open the run dialog, either:
* Select Start>Run, or
* Hold the Windows key and press the “R” key.
Note: If the Start menu item Start>Run is missing you can enable it by right-clicking the Start
menu button. Choose Properties, select the Start Menu tab, click Customize then select

the Advanced tab. In the Start menu items list-box, locate the Run command entry and
check the box against it. Click OK twice to apply the change.

Finding out the IP Address of Your Computer

There are a number of ways to do this. One approach that can relied on irrespective of the
Windows version being used is the command ipconfig.

To use ipconfig, open a command-prompt. Enter the command ipconfig. On entering the
command, the operating system will respond with a series of addresses, note the one labelled
IP Address.
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Determining PC Port Usage

The Windows netstat command can be used to list all the network ports that are currently in
use on a PC. To use netstat, first open a command prompt (see above), then type the
netstat command as follows:

netstat -a -b

The command outputs a table with four columns Protocol, Local Address, Foreign Address and
state. A large amount of text is generated by this command making it difficult to locate an entry.
To assist in locating a particular port save the output of the command to a file using console
redirection, e.g.

netstat -a -b > c:\portresults.txt

The arrow character requests that Windows not show the results on screen but instead puts the
results into a file called portresults.txt at the root of the C drive.

Once the prompt returns, the command has complete, and the file content is ready to review.
Use Windows notepad to view the contents of the results file. Use the find function in Notepad
(Edit>Find) to find occurrences of number sequence, e.g. 8080. Remember that netstat
requests the operating system to list all the ports in use so if port 8080 cannot be found by
Notepad then port 8080 is free to use. If the sequence 8080 is found then that port might be in
use, further analysis of the line containing the sequence 8080 is required to be certain.

If the 8080 sequence is shown under the third column - "Foreign Address" - then this line can be
ignored and the search continued. Also ignore any line found that contains 8080 embedded in
another number, e.g. 128080.

If line contains 8080, and the port number is not embedded in another number and the port
number is under the "Local Address" column then examine the line immediately below the line
to discover what application or service is using this port.

B portresults.txt - Notepad E@@\

File Edit Format Yiew Help

~
TCP  montfort:427 montfort.local:0 LISTENING
[versioncueCs2. exe]

TCk montfort threps montfort.local:0  LISTEMING
[skype. exe]
TCR montfort:microsoft-ds montfort.local:0 LISTEWING

[system] -~

services. 5g
: Find what: 8080
TCP maonti]

—— unknown Direction

[swchost. exg
[ Match case Olp @ Down
TCP montf]
[versionCue
TCP montfort 6051 montfort.Tocal:0 LISTEMING
[awgam. exe]
TCR montfort : 3000 montfort.local:0 LISTENING

[services. serwice. exe]

TCP montfort: montfort.local:0 LISTENING

[ Randamserverlsin

v
< ¥

Figure 26 Determining port usage using the netstat command

The example shows viewing in Windows Notepad, the result of running the netstat command
in a Windows Console and using console redirection to create a file containing a list of ports in
use. The Find Notepad operation has been used to locate a line containing 8080, in the local
address column, and the line after shows that the port is being used by an application called
RandomServerUsingPort.exe.
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Windows Events — Using the Event Viewer

Event Viewer E] @ El

File Acton Wiew Help

¢ AEEFDR @

Lﬁ] Event Viewer (Local) Application 1,986 event(s)
:5 Type ‘ Date | Time Source Cab &
z::;';:;" (B Information  02/07/2008  10:01:26  MSCRMTracing Mon
!i Internet Explorer @Infcrmaﬁon Dz,‘iD?jEDDB 08:39:56 MSCRMTracing MNon
@Infmmaﬁon 02/07/2008 08:38:18 SecurityCenter Mon
l'.'(i)rnfnrmahnn n2in7inng n1:nz:75 i rr)-: bt

Figure 27 Windows Event Viewer

Some services and applications running on a computer need to communicate with the user but
do not have a graphical interface to do so. For these services and applications the operating
system provides methods of recording the occurrence of an event. All the events in the system
are stored in various event logs. The Event Viewer is a convenient method of examining all
events which have occurred recently. Issues concerning the proper functioning of the system
are recorded and allow problems to be solved during commissioning and maintenance cycles.

Viewing Windows Logs

The Windows Event Viewer allows you to view various Windows logs. For a surveillance
system, the most relevant log is the Application Log. The Application Log stores a historical list
of information, warning and error messages related to applications running on the local
computer.

To access this log, open the Control Panel from the Start menu and choose Administrative
Tools. If the Control Panel is in category view, choose the Performance and Maintenance
category, then Administrative Tools. Open the Event Viewer. Double-click the Application log.

When examining the log, note the Source column. This lists the name of the application that
generated the log entry. Entries can be:

* Informational, shown with an i icon.
e Warnings, shown with an exclamation mark icon.
» Severe error, shown with a stop-sign icon.

Surveillance suite software components that have warning or error log entries should be read to
determine the source of the error. The system log can be useful for finding out about computer
issues that might affect the surveillance suite applications indirectly, for example low disk space.

Note: If the Control Panel entry is missing you can enable it by right-clicking the Start menu
button. Choose Properties, select the Start Menu tab, click Customize then select the
Advanced tab. In the Start menu items list-box locate the Control Panel entry and choose
either Display as a link or Display as a menu. Click OK twice to apply the change.
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Configuring Application Log to Overwrite Oldest Entries

B Event Viewer, g@g|
File  Action View Help
& |Em| B 2
Event Yiewer (Local)
4 _ : =
4] securi Open Log File. .. Type Date Time Source Cakegory
iti| Systel  Javelog File As... @Information 01/10f2008 10:08:53 MSSQLESQLEXPRESS (2)
Interr  Mew Log Yiew @Information 01/10/2005 052811 Outlook, Mone
Micros  Clear all Events @Information 01/10/2005 03:28:11 Cutlook, Mone
i iere View > in Application Properties
i
Rename @Inf General | Filker
Refresh @Inf
Export List... @Inf Display name: Application
Inf
Properties %Inf Log name: C:AWINDOWS \system32hconfighéppE vent Evt
Help @Inf Size: S120KE (524,285 bytes]
@I”F Created: 15 September 2008 153:46:36
@I”F Madified: 30 September 2008 14:03:08
%in: Accessed: 30 September 2008 14:03:08
i
E1r Log size
(Eh1n b
(l s Masimum log size: |64 : KB
Opens the properties dialog box For the current s when masimum log size iz reached:
@® i
() Dwenwrite events older than days
(O Da not avenwrite events
[clear log manually) FRestare Defaults
[] Using a low-speed connection
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Figure 28 Changing Windows logging behaviour

The Event Log can become full and prevent proper execution of the tasks running on the
computer. To prevent this, change the properties of the application event log to overwrite
earliest events when there is insufficient space available.

To do this:.

1 From the Start menu open the Control Panel and choose the Administrative Tools. (If the
control panel is in category view, choose the Performance and Maintenance category, then
Administrative Tools.)

Open the Event Viewer.
Double-click the Application log.

Right-click the Application entry in the left-hand window and choose Properties.

ga A W N

In the Application Properties choose the General tab and in the Log size group click
Overwrite events as needed, and click OK.

Viewing Windows Services List

Some parts of the surveillance system run as background tasks and do not require a user to be
logged in for tasks to be run. These background tasks are known as services.

Although services run in the background, do not interact with users graphically, and do not
require a user to be logged in, they are initiated, run and owned by a user account on the
computer. Typically this account is one of the built-in accounts, usually a user called
LocalService or sometimes a user called NetworkService.

Services can be automatically started or stopped by the operating system when it starts or shuts
down. Alternatively, they can be manually started or stopped by a logged in user with sufficient
privileges to do so.

When service-based surveillance suite components are installed, they are installed in a state
that requires a logged-in user with appropriate privileges to start the service.
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The Windows Services list permits a logged-in user with sufficient privileges to:
» Switch a manual service to start automatically.

» Switch an automatically starting service to manual

« Completely disable the service, preventing it from being started.

To open the Services list, from the Start menu open the Control Panel and choose the
Administrative Tools option. If the Control Panel is in category view, choose the Performance
and Maintenance category, then Administrative Tools. Open the Services application.

File  Action View Help
e - m| 2
'% Services {Local) Name Description | Status ] Startup Type ] Log On As Ce-
% .MET Runtime Optimization Service ... Microsoft .MET Framework NGEN Manual Local System
%Alerher Notifies selected users and co... Disabled Local Service
%Applicaﬁon Layer Gateway Service Provides support for 3rd party... Started Manual Local Service T
Application Management Provides software installation ... Manual Local System
%ASP.NEI’ State Service Provides support for out-of-pr... Manual Metwork Service
g&.ﬂm’ HotKey Poller Started Automatic Local System
%Aummaﬁc Updates Enables the download and inst...  Started Automatic Local System
%AVG Anti-Spyware Guard Started Automatic Local System
%AVG? Alert Manager Server Started Automatic Local System
%AVG? Remote Support Service (Avg... AVG Remote Admin helper ser...  Started Automatic Local System
%AVG? Update Service Started Automatic Local System
%Background Inteligent Transfer Ser... Transfers data between dlient...  Started Automatic Local System
Bluetooth Support Service Disabled Local Service
%ClipBook Enables ClipBook Viewer to sto.., Disabled Local System
%COI\‘H Event System Supports System Event Motific...  Started Manual Local System
%COI\‘H System Application Manages the configuration an... Manual Local System
e R O R T N g T ¥
Extended >\ Standard

Figure 29 Windows services application

Right-click and choose Properties to display the Properties dialog for the service.

Video Services Properties (Local Computer)

General |Log On | Recovery | Dependencies

Service name: CS5ervices

Display name: Wideo Services

D escription: Wideo Services for IP Video

Fath to executable:
"'C:\Program Files\WideoServer\Services. Service. exe'’

Startup type: M anual w

Service statuz: Started

*Y'ou can specify the start parameters that apply when vou start the service
fram here.

[ QK. ][ Cancel ]

Figure 30 Configuring start-up action for selected service

To request that Windows start a service when the operating system starts, change the Start-up
type to Automatic. Note that the service will not actually start until Windows is re-started. To
start the service from this dialog, select the required service and click Start.

To change an automatic service back to one that requires a logged-in user to start and stop the
service, change the Start-up type to Manual. Note that a started service will not stop until
Windows is shut down. To stop the service before then, select it in the list and click Stop.
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Note: Informational messages, warnings and error events logged by services can be viewed
through the Windows Event Viewer.

Checking Connectivity of a Networked Device or Computer

During installation, commissioning and when troubleshooting an installed system, it may be
necessary to confirm that a particular network device is reachable. One technique is to use a
network ping. This sends a special data packet over the network that the end party replies to,
once received. Unless configured not to, most networked devices, IP cameras, Networked
DVRs, computers running a server component, computers running a NVR component or
computers running a Video-wall component will reply to incoming ping requests.

To use a network ping you need to know the IP address of the network device you wish to find.

Note: If no response is received from a pinged network device then first ensure you have the
correct IP address for the device. If this is correct, then confirm that you have
connectivity with other network devices before assuming that the device is not
reachable. It might be that the computer from which you are issuing the ping is not able
to reach some, or all networked devices due to a configuration issue with the computer
you are using, a coincidental localised or wider network-connectivity issue, or the
presence of a software firewall preventing ping requests being sent or received.

Sending a Ping

The following steps show how to determine whether a certain device with IP address 10.0.1.7 is
available on the network. It assumes that some checks have been made to ensure that the
computer being used in the test is connected to the same network as the device, and that other
devices known to exist and connected to the network have responded.

1 Open a Command prompt.
2 Typeping 10.0.1.7 and press Enter.

3 If the network device (or computer running a surveillance software component) cannot be
reached then the response will be at least 4 lines indicating “Request timed out”.

WINDOWS\system32\cmd.exe

y] soft Windows KP [Uerszion 5.1.268@1
(C>» Copyright 1985-2081 Microsoft Corp.

C:“Documents and Settings\ping 18.8.1.7

Pinging 18.8.1.7 with 32 bytes of data:

Reply from 18.8.1.7: hytes=32 timedims TTL=128
Reply from 18.8.1.7: hytes=32 timedims TTL=128
Reply from 18.8.1.7: hytes=32 time<ims TTL=128
Reply from 18.8.1.7: bytes=32 time<{imsz TTL=128

Ping statistics for 18.0.1.7:

Packets: Sent = 4. Received = 4, Lost = B (Bx loss>.,
Approximate round trip times in milli—seconds:

Minimum = Bms, Maximum = Bms, Average = Bms

C:~Documents and Settings _

Figure 31 Successful ping reply

» If the network device was reachable then the response will contain several replies.

« If there is a mix of replies and timed out messages, this suggests that a network
connection fault exists, that the network is highly congested, that the target device is too
busy due to heavy workload to reply, or a mixture of these. In this case, this indicates
that there is a system issue which could adversely affect the system’s overall
performance and could result in failed recordings, live or playback requests, and a
general lack of system responsiveness.
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The ping command is a useful troubleshooting tool that can highlight issues affecting the overall
system and is one method that might indicate that the overall system is currently overdriven and
is not operating as designed.

Troubleshooting

Troubleshooting is a complex area when the components of the surveillance suite software, the
underlying operating systems, database managers, rendering engines, the different types of
hardware involved and the various issues related to networking are all taken into consideration.

This section covers some typical issues that occur when installing, running and maintaining the
surveillance system. It also describes how to assist a technical support representative by
providing them with useful information and run-time log files to help them determine the root of a
problem. It is worth noting that by examining the information provided there will be cases where
the solution might be obvious and you can implement a solution without having to contact the
software vendor or other support provider.

It is important to note that a high level of technical competency is required in order to perform
troubleshooting. There are a number of skills required to identify the likely cause of the issues
being experienced and several attempts might be required to solve problems.

It is very important to design a system from the outset rather than to make an arbitrary system
using various hardware elements and using networking infrastructure that has not been
optimised for surveillance use, i.e. not high bandwidth optimised. There are discussions
elsewhere about the importance of design in constructing the surveillance system.

Note: Itis assumed that the overall system (software, hardware and networking infrastructure)
is fit for purpose and has performance safety margins that allow peaks of demand to be
accommodated. It is also assumed that high performance computer hardware is used:
server grade for server and Networked Video Recorder components and that all
computer hardware matches or, preferably, exceeds the minimum specifications.

Caution: Itis highly recommended that computer hardware is NOT used to perform
non-surveillance system tasks unless the interaction between the CCTV and
non-CCTYV aspects of the installation can be safely accommodated within the
specification of the computer and there is no shared dependency, e.g. shared
database manager usage, that compromises the system.

Providing Technical Support Information
All software components have a built-in automatic log file generator. The generator is enabled
whenever a special file called logging.config is detected.
Enabling Logging
To enable logging:
1 Locate a suitable logging.config file and copy it into the clipboard. This will be:

» Inthe installation folder of the software component and called logging.config.disabled (or
some other name that distinguishes it from logging.config), or

* In a sub-folder of the installation folder.

« Alternatively, you might be sent the file by a technical support representative.
2 Close the application you want to log.

» For clients, exit the application.

* For servers or NVR components, stop the service controlling the application.

3 Paste the logging.config file into the installation folder. (If necessary, rename it so that it is
called logging.config.)

Start the application to be logged.

Note that a log-roll.txt file will appear in the application's installation folder.
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Disabling Logging
To disable logging:
1 Close the application currently being logged.
» For clients, exit the application.
» For servers or NVR components, stop the service controlling the application.
Note: Currently the application being logged will occasionally write to the log-roll.txt file.

You will not be able to delete the log-roll file(s) or the logging.config file until the
application being logged is stopped.

2 Remove the logging.config file from the installation folder by moving to a sub-folder, to
another safe location, deleting it (if you have kept a copy) or renaming it to (for example)
logging.config.disabled.

Start the application.
4 Note that after removing any log files in the application's installation folder, no more log files
are added to the folder.

How Logging Works

Caution: The logging.config file contains the operating parameters for the generator and
should not be modified unless you have been instructed to do so.

The log file generator automatically "rolls" the log file every hour. This means that the log-roll.txt
file is renamed to a name starting with log-roll but also appends the date and hour of the day
that the log started on, and a new log-roll.txt file is created containing the next hour's logging
information.

This rolling behaviour has two undesirable side effects:

* When the application being logged is restarted, the log-roll.txt is deleted and a new one
created. This may mean that vital error information gathered prior to the failure of the
application is lost.

To overcome this and capture the last moments of an application's behaviour in the log file,
locate the log-roll.txt and rename it to, for example, log-roll-showing-UAE.txt. This means
when the application being logged is restarted, the log-roll.txt will not be present to be
overwritten.

Note: If the application is still executing and you wish to capture the moment when
something happens, wait until the required moment has passed, then stop the
application. Once stopped, rename the log-roll.txt file as described above, and restart
the application.

» Iflogging is enabled and the system unmaintained for an extended period, the log files may
eventually consume large quantities of storage on the drive where the application is
installed. This could compromise the overall performance of the computer running the
application being logged.

To overcome this, you can safely move or delete log-roll files with dates and times appended
to the file's name, since these are not actively being written to by the generator.
Alternatively, be sure to disable logging once your logging requirements have been met.

Caution: Logging puts extra demand on any system due to the CPU load of executing
surveillance software components and log generator. This could cause system
overload and result in misleading log content.

In some cases where overall system power is limited, enabling logging can put a serious load on
the system, perhaps causing the system to become overdriven. Always ensure that the
computer is able to accommodate the logging overhead on top of normal system operation. If
this is not done, the content of the logs may be misleading since they will reveal an overdriven
system rather than the fault trying to be captured. In such situations alternative approaches to
troubleshooting are required.
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